
สารบัญ 
การสอนและการแนะนําสําหรับ SAP2000 
 
1 บทนํา 

การใชหนังสือคูมือ        1-1 
การแนะนําคราวๆของโปรแกรม      1-2 
การใชการสอน         1-2 

 2 การสอนเปนการแนะนํา 
โครงงาน         2-2 
สวนติดตอ         2-2 
ขั้นที่ 1   เริ่มตนแบบจําลองใหม      2-3 

กําหนดการเลือกรายการอัตโนมัติ    2-6 
ขั้นที่ 2   เพิ่มเฟรม       2-10 

วาดเฟรม       2-10 
การขัดลอก      2-11 
การตกแตง       2-14 
การกําหนดตอนจบ      2-17 
บันทึกแบบจําลอง       2-19 

ขั้นที่ 3   เพิ่มพื้นท่ี       2-19 
กําหนดสวนพื้นที่       2-19 
วาดวัตถุพื้นท่ี       2-20 
แบงวัตถุพื้นท่ี       2-22 

ขั้นที่ 4   เพ่ิมจุดยึด       2-23 
 
 
 
 
 
 
 
 
 
 
 



การสอนเปนการแนะนําสําหรับ SAP2000 เวอรชัน 8 
-------------------------------------------------------------------------------------------------- 

ขั้นที่ 5   กําหนดโหลด       2-25 
ขั้นที่ 6   กําหนดแรงโนมถวง     2-26 
ขั้นที่ 7   กําหนดแกไขความเข็งของพื้นท่ี     2-28 
ขั้นที่ 8   เริ่มการวิเคราะห       2-29 
ขั้นที่ 9   กราฟฟคตรวจดูการวิเคราะห    2-30 
ขั้นที่ 10   ออกแบบเฟรมเหล็ก     2-34 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



บทนํา 
 

การใชหนังสือคูมือน้ี 
  หนังสือคูมือน้ีแนะนําคุณถึง SAP2000 เวอรชัน 8. ตามขั้นตอนเพื่อนําทางคุณผานการพัฒนา
ของแบบจําลองแรกของคุณ ความตั้งใจตองแสดงเปนอยางแรกและเพื่อความรวดเร็วและโดยงาย แบบจําลอง
สามารถถูกสรางขึ้นโดยการใชโปรแกรมนี้ การสอนน้ีไดรับความตั้งใจเพื่อใหถึงมือคุณโดยอยูบนประสบการณการ
ทํางานกับ SAP2000 ซึ่งสําหรับคนสวนมาก วิธีที่รวดเร็วกลายเปนท่ีคุนเคยกับการใชโปรแกรม SAP2000 คือ
หน่ึงอยางที่สุดโปรแกรมอัจฉริยะและทรงพลังกับความสามารถมากมายและฟงกชัน หนังสือคูมือน้ีไมพยายามเพื่อ
ทําเปนเอกสารอยางเต็มท่ีทั้งหมดของความสามารถเหลาน้ัน คอนขางจะ, เราสรุปแสดงวิธีทํางานกับโปรแกรม, การ
ตระเตรียมคําอธิบายจํานวนหนึ่งตามวิธีเพ่ือ ความเขาใจอยางเต็มท่ีของ SAP2000 คุณควรใชหนังสือคูมือการ
สอนเปนการแนะนําน้ีในสันธานกับเอกสารอางอิง SAP2000อื่นๆ. 

เราหวังวาคุณมีความสุขการใชการสอนน้ี, และซึ่งคุณคนหาประโยชนของ 
มันเปนจุดท่ีเริ่มตนในการคนหาของคุณของสิ่งน้ีทรงพลังและที่ครอบคลุมเวอรชันของSAP2000. 
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การแนะนําคราวๆของโปรแกรม 
  SAP2000 คือโปรแกรมทางโครงสราง finite-element พื้นฐาน ที่ทํางานไดอยางอิสระสําหรับ
การวิเคราะหและการออกแบบของโครงสรางภายในยังหนึ่งรูเอง, ทรงพลัง สวนติดตอผูใชกับเครื่องมือมากมายเพื่อ
ชวยเหลือในการกอสรางที่รวดเร็วและแนนอนของแบบจําลอง, ตามดวยเทคนิควิเคราะหแยกแยะสมัยใหมที่
ตองการเพื่อทําโครงงานที่ซับซอนมากท่ีสุด SAP2000 คือวัตถุพื้นฐาน, ความหมายคือ แบบจําลองซึ่งถูกสรางโดย
สมาชิกซึ่งนําเสนอความจริงทางกายภาพ ซึ่งรวมกับหลายสมาชิกเขาไปใน SAP2000 ถูกสรางเปนวัตถุเด่ียว 
เชนเดียวกับ ที่มันมีอยูในโลกจริงๆ  และ ทําการแยกยอยเพื่อใหแนใจวาการติดตอกับสวนอื่นๆ ถูกจัดการภายใน
โปรแกรม ผลลัพธสําหรับการวิเคราะหและการออกแบบถูกทําเปนรายงานสําหรับวัตถุครอบคลุม, และไมสําหรับ
แตละ element ยอยซึ่งทําขึ้น การตระเตรียมขอมูลวาคือทั้งคูงายกวาเพ่ือตีความและอยูกับรองกับรอยมากขึ้นของ
โครงสรางทางกายภาพ. 
 
การใชการสอนนี้ 
  ตัวอยางในการสอนนี้ตระเตรียมคําพรรณนาเปนขั้นตอนโดยใช SAP2000. เราแนะนําซึ่งคุณทํา
ตามขั้นตอนน้ีตามความเปนจริงใน SAP2000 ขณะที่อานหนังสือคูมือน้ี 
  โปรแกรม SAP2000 ตองถูกติดต้ังบนคอมพิวเตอรของคุณกอนคุณสามารถเริ่มตนการสอน. 
มันยังเปนแนวความคิดท่ีดีเพื่อความเขาใจในสิ่งอื่นๆภายในเอกสารอางอิง SAP2000 กอนเพื่อการเริ่มตนการสอน
น้ี, หรืออยางนอยมีคูมืออยูระหวางการสอนถาตองการ. 
  ถาคุณตองการดูคูมือการใชงานคุณสามารถดูไดจากแฟม ที่เปนนามสกุล .pdf เราของแนะนํา
ใหคุณพิมพออกมากอนท่ีคุณจะเริ่มการเรียนรู มันไมใชแบบฝกหัด ของการใช Sap 2000 น้ี ในขณะที่คุณกําลัง
อานมันบนหนาจอของคุณ 
  ระหวางการเรียนรู น้ี เราจําเปนตองสํารวจความสามารถพื้นฐานของ Sap2000 น้ี โดย
ตระเตรียมอยางนอย หน่ึงชั่วโมงผานไปสําหรับตัวอยางน้ี และถาคุณตองหยุด คุณตองทําการบันทึกแบบจําลอง
น้ันไวเพื่อทําการตอไป 
 
ยินดีตอนรับสู Sap2000 
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แนะนําการสอน 
 
 บทนี้ไดตระเตรียมอยางเปนขั้นตอนสําหรับโครงสรางพื้นฐานของแบบจําลอง Sap2000 แตละขั้นตอน
ของกระบวนการการสรางแบบจําลองและแนะนําเทคนิคการกอสรางแบบจําลอง ท่ีทําในบทนี้ โงที่แสดงในภาพที่ 1 
 
 

 
รูปที่1 แบบจําลอง 
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โครงงาน 
 การสอนโครงการแบงเปน 5 ขั้นตอน คือ ความชันของสะพาน, ความยาวของสะพาน 60 ฟุต, มีคาม
กวางและสงู 12 ฟุต, ปลายขางหนึ่งเปน rollers และเปน pins ท่ีอีกจุกหน่ึง. 

 ตัวสะพานและโครงทักใชเหล็ก 2L4x4, โดยมีแผนพื้นหนา 5 น้ิว สะพานจะถกูวิเคราะหสําหรับโหลด
คงที่เทาน้ัน, โดยแผนพื้นรับโหลดตายตัว 10 ปอนด/ฟุต2 (psf) และมีโหลดจร 100 psf 
 
สวนหนาตาหลัก 
 บรรทัดบนสุดเปนเมนูท่ีรวบรวมคําสั่งและขอกาํหนดตางๆที่มีใน Sap2000, รวมถึงขอกําหนด, การวาด, 
การเลือก, การระบุ, การวิเคราะห, การแสดงผลและการออกแบบ. เมนูท่ีแสดงรายการเหลาน้ีไดถูกบรรจุคําสั่งทีใ่ช
งานบอยท่ีสุดใน Sap2000, และใชบอยมากท่ีสุด คําลั่งสามารถเขาถึงขอมูลไดโดยกดปุมเพียงปุมเดียวในบริเวณ
หนาจอที่อยูบริเวณรอบพื้นท่ีท่ีใชวาดการใชประโยชนไดของปุมถูกแสดงในเมนูหลัก โดยแสดงเปนรูปของไอคอนที่
อยูดานซายและมุมลางขวาแสดงในสวยของหนวยที่ใช ภาพท่ี 2 แสดงภาพทั้งหมดของหนาตาหลัก 

 
ภาพที่ 2 แสดงภาพทั้งหมดของหนาตาหลัก 
 
 
 

2- 2 



ข้ันตอน 1 เริ่มตนแบบจําลองใหม 
 ในขั้นตอนน้ี เสนโครงรางจําถูกกําหนดใหรองรับแบบที่จะทําโมเดล และเมื่อรายการหนาตัดของเหล็กฉาก
คูจะถูกกําหนดใหเลือกแบอัตโนมัติ  
 
A คลิกท่ี File Menu > New Model หรือปุมคําสั่ง New Model  , และหลังจากนั้นจะแสดงดังภาพที่ 3 
ซึ่งหนวยที่ใชจะเปนหนวยของ Kip-in 

 
B. จะแสดงรูปรปูการสรางโมเดลที่งายและรวดเร็ว, อยางไรก็ตามการเริ่มตนการสอนนี้เราจะเริ่มตนกนดวยการ
สรางเสนโครงราง, มันจะถูกกําหนดดวยลักษณะทางเรขาคณิต.มันจําเปนท่ีตองเปนรูปเรขาคณิต เพราะการ
นําเสนอน้ีเกี่ยวกับแบบจําลองที่เปนเรขาคณิต ดังน้ันมันสมควรที่จะกําหนดหมายเลขของเสนโครงโดยกําหนดทั้ง
ความสูง และความกวาง โดยเลือกในรูป ของ Grid Only แลว จะแสดงผลดงัในรูปภาพ ท่ี 4 
 
 
 
 
 
 



 
 
 
 
 
 
 
 

ง

 
 

 
 
 
 
 

C. ระบบ New Coord/Grid System ใชระบุเจาะจงก
กําหนดใหชองเสนโครงรางในแกน X เปน 10 และแกน Y
โดยใหเสนในแกน X ยาว 6 ฟุต โดยสามารถพิมพ 6ft 
และใหท้ังเสนแกน Z และ Y ยาว 12 ฟุต (144น้ิว)  
 
 
 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 4 
ระบบการสรา
เสนโครงสราง
ารสรางเสนโครงรางในแกน X,Yและ Z โดยเราจะเริ่ม
และZ ใหเปน 1 และกําหนดความยาวของเสนโครงราง 
ไดเลยโดยหนวยจะเปลี่ยนใหเองอัตโนมัติ เปน 72 น้ิว 
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รูปภาพที่ 5 หนาตางของ SAP2000 
 
D. คลิก ปุม OK เพื่อยอมรับในสิ่งที่เปลี่ยนแปลง ดังในรูปภาพที่ 5 จะเห็นเปนรูปเสนโครงราง ท้ังสองหนาตาง ท้ัง
ในระนาบ X, Y ดานซายและ ในรูปแบบ 3D ทางดานขวา โดยเราสามารถเปลี่ยนมุมมองไดโดยการ คลิกท่ีคําสั่ง 
Options menu > Windows 
 
บันทึก ระนาบในรูปภาพที่ 5 มันจะแสดงระนาบที่มองในการมอง สองมิติ ในรปูสามมิติ โดยจะแสดงเปนเสนสฟีา 
 
บันทึก ในรูปจะแสดงแกนหลกัของภาพโดยที่มีแกน Z เปนแกนที่แทนแกนแรงโนมถวงโลกที่ ติดลบ หรือมีทิศลง 
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กําหนดการเลือกหนาตัดอัตโนมัติ 
 การเลือกหนาตัดแบบอัตโนมัติเปนวิธีการเลือกอยางงายๆ จากรายการของหนาตัด ซึ่งในการสอนนี้จะ
เปนชุดหนาตัดเหล็กฉากคู(2L4x4) รายการเลือกอัตโนมัติเปนชุดท่ีกําหนดลักษณะเฉพาะของวัตถุ เม่ือเลือกให
เปนการเลือกแบบอัตโนมัติ โปรแกรมจะทําการเลือกหนาตัดท่ีประหยัดท่ีสุด และสามารถเลือกหนาตัดจากรายการ
ท่ีใชออกแบบไดอยางเพียงพอกบัเฟรม และเมื่อเริ่มทําการวิเคราะห โปรแกรมจะจะกําหนดหนาตัดจากรายการเพื่อ
คุณสมบัติการวิเคราะหจะไดถูกตอง 
 สําหรับการสอนพิเศษน้ี โปรแกรมจะวิเคราะหและออกแบบจากชุดหนาตัดเหล็กฉากคู ซึ่งจะเลือกจาก
รายการหนาตัดโดยอัตโนมัติดังที่จะสรางดังน้ี 
 A. คลิกเลือกคําสั่ง Define menu > Frame/Cable sections ซ่ึงจะแสดงคุณสมบัติของเฟรมดูไดจาก 
              รูปที่ 6 
 
 
 
 
 
 
 
 
 
 
 
 
 B. เลื่อนคุณสมบัติของหนาตัดลงมาตามรายการที่เห็น ท่ีมีขนาด 2L4x4 s, ถาทําแลว, ขามไปขั้นตอน D  
              หรือมิฉะน้ันใหดําเนินการขั้นตอน C  
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 C. คลิกท่ีสวนลาง ในชองที่อานวา “Import I/Wide Flange” ในสวนของ Choose Property Type for  
                   Add ในสวนของขอความโดยเลื่อนลงมาสวนลางในการปอนขอมูลโดยคนคําวา Import Double  
                   Angle – ดังรูปที่ 7 โดยคลิกตามน้ัน 

 

รูปภาพที่7 
 Import 
Double 
Angle 

 D. ใหคลิกในบริเวณของ Frame Properties คลิกท่ีปุม Add New Property ซ่ึงจะเปด file ท่ีเปน 
              ขอมูลของหนาตัด  
 E. เลือกและเปด file ท่ีชื่อ SECTIONS8.PRO จาก file คุณสมบัติของหนาตัด เชนเดียวกนักับที่ปอน 
              ขอมูลของเหล็กฉากคูท่ีใชใน Model. ซึ่งรายการของ Sections8 จะแสดงดังในรปูภาพที่ 8  
 F. เลื่อนลงมาในสวนของหนาตัดเหล็กฉากคู โดยคุณหาในสวนของ 2L4x4 ท้ังหมด โดยคลิกแถบแสง 
             คอมเอาไว 
 G. เลื่อนลงมาโดยเลือกในสวนของ 2L4x4 โดยกดปุม shift คางไว แลวเลื่อนลงมาคลิกอีกทีท่ี  
                   2L4x4x7/16 ซึ่งจะเปนการเลือกสวนของ 2L4x4 ท้ังหมด 
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H. คลิกปุม OK และจากนั้นกค็ลิกปุม OK ในสวนของ Double Angle Section จากการเลอืกหนาตัด     
    เหล็กฉากในรายการของคุณสมบัติจากระบบของ Frame Properties  

 

รูปภาพที่ 8  
หนาตัดจากรายการ 
Sections8.pro 

 
I. คลิกในชองขางลางที่อานวา “Add I/Wide Flange” ในตัวเลือกของชนิดคุณสมบัติสําหรับเพิ่มพื้นท่ี 
   ของคุณสมบัติเฟรมจากน้ันใหเลื่อนลงมา เลือกท่ีคําวา Add Auto Select แลวกดคลิก 
J. ในการคลิกเลือกพ้ืนท่ีจาก Frame Properties ใหคลิกท่ีปุม Add New Property ซึ่งจะเปนการเปด
การเลือกอัตโนมัติซึ่งจะแสดงในรูปที่ 9 ทําเปน 
K. พิมพคําวา TRUSS ในสวนของ Auto Sections Name 
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 L. เลื่อนลงมาในรายการหาคําวา 2L4x4x1/2 แลวคลกิใหขึ้นแทบแสง 
 M. และตอจากน้ันเลื่อนลงมาในสวนของรายการโดยกดปุม Shift คางไวแลวเลือกท่ี 
               2L4x4x7/16, ซึง่จะขึ้นแทบแสงคอมท้ังหมดของ 2L4x4 
 N. คลิกปุม Add เพื่อยายในสวนที่เลือกจากรายการไปไวในสวน Auto Selections  
              ทางดานขวาของระบบ 
 O. คลิกปุม OK และก็คลิกปุม OK ในสวนของ Frame Properties เพ่ือยอมรับในการ 

    เปลี่ยนแปลงและเพิ่มในสวนชื่อ TRUSS ในสวนของชอง Properties 
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ขั้นท่ี 2 เพิ่มเฟรม  
 ในขั้นตอนน้ี เฟรมที่เกี่ยวของกบั ฟงกชันท่ี ชื่อ TRUSS ของรายการจะถูกใชในการวาดบนเสนโครงราง
ซึ่งสามารถแกไขไดจากคําสั่งบนเมนู 
 
การวาดเฟรม 
ใหแนใจวาอยูบนระนาบ Xและ Y โดยที่แกน Z = 0 วิว (ดูจากระนาบที่อยูตํ่าสุด) ท่ีแสดง (ดูจากขั้นตอนที่ 1- D 
สําหรับรูปแบบและทิศทางที่แสดงใหเห็นดังในหนาท่ี 2- 14 สําหรับการตั่งคามุมมอง) มุมมองน้ีควรอยูดานซายของ
หนาตาง. ซึ่งจะเช็คโดยปุมของ Snap to Point and Grid Intersections. สิ่งน้ีจะชวยระบุตําแหนงที่แนนอนของ
เฟรม. สิ่งน้ีจะเริ่มทํางานเมื่อกดปุมท่ีเกี่ยวของโดย  จะยุบลงไป. โดยอีกทางหนึ่ง, ใชกดคําสั่งบนเมนู Draw > 
Snap to > Points and Grid Intersections โดยท่ัวไป, คําสั่งน้ีจะทํางานอยูแลว. 
 

A. คลิกท่ี Draw Frame/Cable ปุม  หรือ ใชคําสั่ง Draw menu > Draw Frame/Cable ถาคุณ
เขาใจถึงคําสัง่การวาด Frame/Cable ผาน เมนูการวาด. ปุม Frame/Cable จะยุบลงไปเมื่อคุณเลือก
คําสั่งน้ี.  ในสวนของ Properties of Object จะปรากฏดังจะแสดงในรูปภาพที่ 10 

 
ในสวนของ Properties of Object จะครอบคลุมทกมุมมองในสวนของเฟรมทุกชิ้นสวน, โดยการคลิก
ลากมันไปวิถ ี
B. คลิกในสวนของ Property เพื่อแกไข ท่ีอยูใน Properties of Object และเลื่อนลงมาเลือกท่ีคําวา 
TRUSS เพื่อเปนการเลือกหนาตัดท่ีอยูใน TRUSS โดยอัตโนมัติ แลวจากนั้นคุณก็วาดมันลงไป 
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C. เริ่มตนวาดเฟรมแรก, คลิกซายหนึ่งทีในระนาบ X-Y ท่ีจุดกําเนิดและคลิกเมาสอีกทีเม่ือลากเมาสไป
ทางดานขวาในแนวนอนตามเสนโครงราง (ท่ี X=720, Y=0) โดยที่ตําแหนงของลูกศรจะอยูตํ่ากวา
หนาจอทางดานขวามือซึ่งเฟรมจะแสดงทั้งสองหนาตาง (ท้ังระนาบและ 3 มิติ) หลังจากที่คลิกจุดสิ้นสุด
ของเฟรมใหคลกิขวา เพื่อ “ยกปากกา” เพื่อท่ีคุณจะไดไมตองวาดเฟรมยาวๆและเปนการยกเลิกการวาด
เฟรม/เคเบิล เพื่อท่ีจะใหคุณทําการเพิ่มเติมสวนอื่นๆ 
 ถาคุณเกิดขอผิดพลาดขณะวาดใหคุณกดปุม Select Object  เพื่อออกจากการวาดไปเลือก
โหมดอื่น โดยคลิกท่ี Edit menu > Undo Frame Add และทําซ้ําตามขอ A-C 
D. ทําซ้ําขอ C วาดเฟรมเพิ่มขนานกับเฟรมแรกที่ตําแหนงจาก (X=0, Y=144) ถึง (X=720, Y=144) 
โดยใชเฟรมที่มีคุณสมบัติของ TRUSS และคลิกขวาเพื่อหยุดการวาด 
E. คลิกซายท่ี (X=0, Y=0) ตอจากน้ันไปที่ (X=0, Y=144) วาดเฟรมขวางกบัอันแรก 
F. คลิกท่ีปุม Select Object  หรือกดที่ปุม Esc บนแปนคียบอรดเพื่อออกจากคําสั่งการวาด 
 
คําสั่ง คัดลอก(Replicating Objects) 

 เพื่อใหแนใจวาคําสั่งอยูในโหมดนี้ 
A. เลือกเฟรมที่ต่ังฉากที่อยูระหวางแกนตามยาวโดยใหคลกิซายบนเฟรมหรือคลิกซายดานขวาของเฟรม 
    และกดเมาสดานซายคางไวจากน้ันใหลากเมาสขามเฟรมดูจากรูปภาพที่ 12 

 B. คลิกท่ี Edit menu > Replicate ทําตามคําสั่งที่แสดงในรูปภาพที่ 11 
 C. คลิกท่ีแถบ linear แลวพิมพ 144 ในชองของ dx  
 D. พิมพ 5 ในชองของ number 
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 E. กดปุม OK บันทึก.วาเฟรมตามขวางไดถูกสรางขึ้นบนเสนโครงรางแลว 

                   

สว

 
 
 
 
 

รูปภาพที่ 11 
นการคัดลอก 
                     
 

 
รูปภาพที่ 12 
Graphical 
Selection 
Options 
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 F. คลิกซาย 1 ครั้งบนเฟรมตามยาวเพื่อท่ีจะเลือกมัน 
 G. คลิกท่ี Assign menu > Frame/Cable > Automatic Frame Subdivide แสดงตามภาพที่ 13 แลว 
     เลือกท่ี Auto Subdivide Frame และคลิกถูก ท่ี at Intersection Joints และ at intersection with  
       Other Frame แลวคลกิ OK  
  
 การแบงยอยน้ี จําเปนตองใหแนใจวามีการเชือ่มกันระหวาง Chords และ members อื่นๆ เพราะวา 
Chords จะถูกสรางขึ้นเปนแบบ Single Physical Objects จากหลักการวิเคราะหน้ี Chords จะถูกเชื่อมตอกับทุก
สวนของเฟรม แตสําหรับการออกแบบและการเลือกจะถูกกําหนดใหเปนวัตถุชิ้นเดียว 
  

                                       

รูปภาพที่ 13 
Assign 
Automatic 
Frame 
Subdivide 
form 

  
H. คลิกท่ีปุม Select All  หรือ ใช Select Menu > Select > All เพื่อเลือกวสัดุตางๆทุกโครงสราง 

 I. คลิกท่ี Edit menu > Replicate จะแสดงรปูแบบของReplicate  
  1. พิมพ 72ในชองของ dx พิมพ 0 ในชองของ dy และพิมพ 144 ในชองของ dz  
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  2. พิมพ 1 ในชองของ number 
  3. กด OK เพื่อยอมรับการเปลี่ยนแปลง 
      เฟรมที่อยูดานลางจะถูกคัดลอกไปไวดานบนโดยเลื่อนไปในแนวแกน X 12 น้ิว  
 
การตกแตงวัตถ(ุTrimming Object) 
 

เพื่อใหแนใจวาอยูในโหมดนี้ใหเลือกดูมุมมองท่ีระนาบ X-Y 
 A. คลิกคําสั่ง View menu > Set 2D View 
      1. เม่ืออยูในรูปแบบของ 2 มิติ ใหคลิกมุมของในระนาบ X-Y 
    2. พิมพ 144 ในชอง Z เพ่ือท่ีจะให Frame อยูดานบน 
 B. คลิกคําสั่ง Assign menu > Clear Display of Assigns เพื่อเอาเฟรมที่แบงยอยออก 
 C. คลิกท่ี Chord บนสุดท้ัง 2 ขางและเฟรมที่ต่ังฉากดานขวาและอีก 2 เฟรมที่อยูปลายของเฟรม 
    ดานขวาสุด ดังแสดงในรูปภาพที่ 14 ซึ่งจะเลือกเฟรมตามเสนขางลาง 

 

รูปภาพที่14 
Select 
mode for 
Trim 

 
 
 
 
 

2-14 



 D.คลิกท่ีปุมคําสั่ง Edit menu > Trim/Extend Frames จะปรากฏ สวนของ Trim/extent Selected  
     Frame 

  1.เลือก Trim Frame Option และกด OK  
เลือก Trim Frames จะตัด 2 chord ดานบนและเฟรมที่ต้ังฉาก, เพ่ือตัดเฟรม, เลือกเฟรม, เลือกเฟรมที่
จะตัดและเลือกจุดท่ีอยูดานบนของเฟรม 
E. คลิก “orphaned” ของเฟรมที่อยูขวาสุดและไปที่คําสั่ง Edit menu > Delete หรือ กดปุม Delete   
   บนคียบอรด 
F. เพื่อใหแนใจวาอยูในระนาบ ใหทําใหอยูในมุมมองของระนาบ XZ  แบบจําลองของคุณตอนนี้จะ 
   แสดงดังในรปูภาพที่ 15 

 
 
 
 
 
 
 
 
 
 

รูปภาพที่15 
Model after 
frame 
objects 
have 
been added 
in plan 
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 G. กดที่ปุม Draw Frame/Cable  หรือคําสั่ง Draw menu > Draw Frame/Cable และจะ 
    ปรากฏสวนของคุณสมบัติของเฟรม 
H. เพื่อใหแนใจวาคุณสมบัติท่ีใชเปนแบบเดียวกับ TRUSS 
I. การวาดเสนทแยงมุม, คลิกซายหนึ่งครั้งในมุมมองของ XZ และกดอีกทีท่ีตอนปลายของ Chord ท่ี  
   (X=72, Z=144) แลวคลิกขวาที่ (X=144, Z=0) จะไดเสนทแยงมุมสองเสน 
 
ตอนนี้เสนทแยงมุมไดถูกวาดแลว 
J. คลิกขวาและกดที่ปุม Select Object  หรือกด ปุม ESC บนคียบอรด เพ่ือออกจากการวาด  
    Frame/Cable 
K. คลิกเมาสเพื่อคลิกคอมท้ังสองเสนทแยงมุม เพื่อเลือก ดังขัน้ตอนในรูปภาพที่ 12 เพื่อเลือก 
L. คลิก Edit > Replicate และจะปรากฏหนาตางของ Replicate 
 1. พิมพ 144 ในชอง dx พิมพ 0 ในชอง dy และ 0 ในชอง dz 
 2. พิมพ 4 ในชองของ Number 
 3. กด OK เพื่อยืนยันการเปลี่ยนแปลง 
เม่ือไดเสนทแยงมุมท้ังหมดที่ประกอบเปนโครงทัก 
M. คลิกเมาสเพื่อคอมโดยลากจากขวาไปซายสดุ (เลือกท้ังหมด) 
N. คลิก Edit > Replicate แลวจะปรากฏ หนาตางของReplicate 
 1. เลือกในสวนของ Linear พิมพ 0 ในชองของ dx, 144 ในชอง dy และพิมพ 0 ในชอง dz 
 2. พิมพ 1 ในชอง Number 
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3. คลิก OK เพ่ือยืนยันการเปลี่ยนแปลง 
 แบบจําลองที่สรางจะปรากฏดังรปูภาพที่ 16  
 

 
 
 
 
 
 

 เ
  
  
ภาพท่ี 17
 
 
 
 

รูปภาพที่ 16 
Model after all frame 
objects have been added 
 
กําหนดการสิ้นสุดของเฟรม (Assigning Member End Releases) 

พื่อใหแนใจวาอยูในโหมดนี้ใหอยูในระนาบ XZ แลวทําดังน้ี 
A. คลิกคอมเพื่อเลือกเสนทะแยงมุมท้ังหมดโดยคลิกจากซายไปขวา 
B. คลิก Assign menu > Frame/Cable > Releases/Partial Fixity แลวจะปรากฏรูปดังใน

 คลิกท่ี Moment 33(Major) โดยคลิกถูกท้ังในชองของ Start และ End Releases  
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 โดยเปนการกําหนดโมเมนตหลัก, ในเฟรมเสนทะแยงมุม จะมีคุณสมบัติเปน Pinned Element 

 

รูปที่ 17 
Assign Frame 
Releases 
form 

 C. คลิก OK เพ่ือยืนยันการเปลี่ยนแปลงและกลับสูหนาจอหลัก 
 D. คลิก View menu > Set 2D View ในหนาตาง 2D View ใหคลิกเลือกท่ีคลิกท่ีระนาบ XZ และ 

   พิมพ 144 ในชอง Y= แลวจะปรากฏมุมมอง 2 มิติ และเลือกใชปุม Move Up in list  เพ่ือเลื่อน 
   ดูระนาบ 
E. คลิกคอมเพื่อเลือกท้ังหมดจากขวาไปซาย 
F. คลิกคําสั่ง Assign menu > Frame/Cable > Releases/Partial Fixity แลวปรากฏหนาตาง Assign  
     Frame Releases ขึ้นและเพื่อใหแนใจวาเปน Moment33 (Major) ใหคลิกถูกในชองของ Start และ 
    End Releases และคลกิ OK เพื่อรับการเปลี่ยนแปลง 
G. คลิก Assign menu > Clear Display of Assigns เพื่อลบเฟรมที่มีจุดตอท่ีเหมือนกัน 
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 บันทึกโมเดล  
 ระหวางการพัฒนาควรบันทึกแบบจําลองบอยๆถึงแมคุณจะเซฟชื่อเดียวกันแตคุณควรที่จะเซฟชื่อตางกัน 
 เพื่อเซฟการเปลี่ยนแปลงในการพัฒนา 
 A. คลิก File menu > Save หรือคลิกปุม Save  เพื่อบันทึกและเจาะจงไดเรคเทอรี่ท่ีคุณตองการ 

   บันทึกโมเดล, สําหรับการสอนนี้ใหเซฟที่ชื่อ TRUSS 
 

ขั้นท่ี 3 การเพิ่มพื้นท่ี 
 ในขั้นน้ีจะเปนการเพิ่มแผนพื้นคอนกรีตในแบบจําลอง 
 
 การกําหนดหนาตัดของแผนพื้น 
 ทําใหอยูในระนาบ XZ โดยเปลี่ยนมุมมองและกําหนดคุณสมบัติของแผนพื้นคอนกรีต 
 
 A. คลิกปุม XY View  ซึ่งจะแสดงในระนาบของพื้น 
 B. คลิกคําสั่ง Defile menu > Area Section แลวจะปรากฏหนาตางของ Area Section 
 C. คลิกท่ีปุม Add New Section เม่ือคลิกแลวจะปรากฏหนาตางของ Area Section ดังแสดงใน 

   รูปภาพที่ 18 
  1. พิมพ DECK ในชองของ Section Name  
  2. กําหนดความหนา (ท้ัง Membrane และ Bending) เทากับ 5 น้ันหมายความวา มีคอนกรีต 

   หนา 5 น้ิว 
  3. คลิก OK แลวก็คลิก OK ในหนาตางของ Area Section เพื่อยืนยันการเปลี่ยนแปลง 
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การวาดแผนพื้น (D
 ทําใหอยูใน
 A. คลิกป

    ปรากฏ
เพื่อใหแนใจวาแผน
มาเลือกท่ีคา DECK

 
 
 
 

รูปภาพที่ 18 
Area Section 
form 
 

 

 
raw the Area Object) 
ระนาบ XY @Z=0 ซึ่งในการสอนนี้ ในการวาดแผนพื้นจะใชคําสัง่ดังตอไปนี ้
ุม Draw Quad Area Element หรือใช Draw menu > Draw Quad Area ซึ่งจะ 
หนาตางของคุณสมบัติของแผนพื้นซึ่งจะแสดงในรปูภาพที่ 19 
พื้นท่ีวาดมีคุณสมบัติเปน DECK ถาไมใช ใหคลิกในชองของ Property โดยเลื่อนลง 

 จากรายการ 
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รูปภาพที่ 19 
Properties of 
Object box 

  B. คลิกคําสั่ง Snap to points and Grid Intersections ซึ่งสิง่น้ีจะเปนตัวชวยในการวาด 
    แผนพื้น 
C. คลิกหน่ึงครั้ง ท่ี (X=0, Y=0) โดยเลื่อนเมาสตามเข็มนาฬิการอบ Model และกดตามลําดับ 
   เพื่อวาดแผนพื้น (X=0, Y=144), (X=720, Y=144) และ (X=720, Y=0) 
D. คลิกท่ีปุม Select Object  หรือ กด ESC บนแปนคียบอรด เพื่อออกจากคําสั่งการวาด 
    แผนพื้น 
E. เพื่อท่ีจะดูแผนพื้นท่ีวาดใหคลิกท่ีปุม Set Display Options  หลังจากนั้นใหคลิกถูกท่ี 
   ชองของ Fill Object และ Apply to All Windows ดังแสดงในรูปภาพที่ 20 

 
 รูปภาพที่ 20 

Display Options for 
Active Windows form 

 
 
  F. คลิก OK เพื่อยืนยันการเปลี่ยนแปลงแลว Model จะปรากฏดังในรูปภาพที่ 21 
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 รูปภาพที่ 21 

Model after the area 
objects have been drawn 

 
 
 ขั้นท่ี 4 การแบงพื้นท่ี (Mesh the Area Object) 
  ทําใหอยูในระนาบ XY @Z=0, สําหรับหัวขอน้ีจะเปนการแบงวตัถุแผนพื้นใหเปนวัตถุท่ี 
 แบงเปนตาราง 
 A. เลือกคลิกคอมบริเวณแผนพื้นท้ังหมดเพื่อเลือก 
 B. คลิกบริเวณใดๆในแผนพื้น ซึ่งวัตถุน้ีจะถูกแสดงงในมุมตํ่า 
 C. คลิกคําสั่ง Edit menu > Mesh Area แลวจะปรากฏหนาตาของ Mesh Shells  
 
 เน่ืองจากแผนพื้นท่ีวาดในตอนแรกเปนชิ้นเดียวแตตองการแบงใหเปนแผนพื้นยอยจึงตองทําดังที่กลาวมา 
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 โดยการเชื่อมตอตามจุดตอของเฟรมบนแผนพื้น ซึ่งเปนการแบงเปนตารางไมใชการแบงแบบทัว่ไป 
 D. คลิกบน Mesh using Selected Joints on edges และคลิก OK แลว Model จะเปนดังใน 

    รูปภาพที่ 22 

 
 
 
 

รูปภาพที่ 22 
Model after re-mesh 
of DECK area object

ขั้นท่ี 4 เพิ่มจุดยึด (Add Restraints) 
 ในขั้นตอนน้ีจะกําหนดจุดรองรับของโครงทักของสะพาน โดยใหมุมมองอยูในระนาบ XY @Z=0 แลว 
 เขาสูโหมดการเลือก 

A. คลิกท่ีปลายดานขวาสุดท่ีเปนจุดปลายของเฟรม 
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B. คลิก Assign menu > Joint > Restraints แลวจะปรากฏหนาตางของ Joint Restrains ดังใน 
   รูปภาพที่ 23 

 
 

 

 
 
 
 
 
 
 
 
 
 

รูปภาพที่ 23 
Joint 
Restraints 
form 
 
 

C. คลิกท่ีปุม roller  ซึ่งเปนการเลือกแบบ Translation 3 ท้ัง 2 จุด แลวคลิก OK เพื่อยืนยันการ    
   เปลี่ยนแปลง 
D. คลิกท่ี 2 จุดดานซายสุดซึ่งเปนจุดท่ีปลายเฟรม โดยเลือกท้ัง 2 จุด 
E. คลิกท่ีคําสั่ง Assign menu > Joint > Restraints ซึ่งจะปรากฏหนาตางของ Joint Restrains 

F. คลิกปุม pinned  ซึ่งเปนการเลือกแบบ Translation 1, 2&3 แกน สําหรับทั้ง 2 จุด แลวคลิก  
     OK เพื่อยืนยัน การเปลี่ยนแปลง 

G. คลิก File menu > Save หรือกด ปุม Save  เพื่อเซฟ Model  
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ขั้นท่ี 5 กําหนดโหลด (Defile Load Cases) 
 โหลดที่ใชในการสอนนี้จะประกอบดวยโหลดตายตัวและโหลดจร โดยมีทิศตามแรงโนมถวงโลก 
 
 สําหรับตัวอยางน้ี ประมาณวา สะพานมีนํ้าหนักตายตัวที่  10 Ib/ft2 (psf) ท่ีเปนแผนพื้นคอนกรีตและมี 

โหลดจรกระทํา 100 psf บนแผนพื้น 
A. คลิกคําสั่ง Defile menu > Loads จะปรากฏหนาตาง Defile Loads ดังแสดงในรูปภาพที่ 24  
หมายเหตุ ในที่น้ีสามารถกําหนดใหโหลดมีเพียงแบบเดียวถาเปนโหลดตายตัวจะปรากฏเปนคําวา 
  (DEAD) 
หมายเหตุ ในชองของ Self weight multiplier ท่ีกําหนดเปน 1 น้ัน หมายความวาโหลดจะกระทําโดย 

  อัตโนมัติทุก 1 หนวยเวลาทุกเฟรม 

 
  
 ใน Sap 2000ท้ังโหลดและการวิเคราะห มันอาจมีความแตกตางกัน อยางไรก็ตาม ตัวโปรแกรมจะสราง
ความคลายคลึงโดยอัตโนมัติ เม่ือโหลดไดถูกกําหนดและการวิเคราะหเปนตัวตรวจดู เม่ือมีการเริ่มให Run 
 B. คลิกในชองของ Load Name แลวพิมพคําวา LIVE แลวเลอืกประเภทของโหลดโดยเลื่อนลงมาจาก 

   รายการ 
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 เลือกคําวา LIVE แลวใหในชองของ Self Weight Multiplier เปน 0 คลิกปุม Add New Load เพื่อ
เพิ่มโหลดจร ลงไปในรายการ 
 การกําหนดโหลดจะแสดงในรูปภาพที่ 25 คลิก OK เพื่อยืนยันสําหรับการเพิ่มโหลดที่เปนจริง 

 
 
 
 
ข
 
ใ
 

 

 
 
 

รูปภาพที่ 25 
The Define Loads form after 
all load cases have been defined 
ั้นท่ี 6 กําหนดแรงโนมถวง (Assign Gravity Load) 
ในขั้นน้ี แรงโนมถวงตายตัวและจรจะกระทําบนโมเดล โดยทําใหอยูในมุมมองระนาบ XY @Z=0 และ

หโปรแกรม อยูในโหมดเลือก 
A. ใหคุณคลิกคอมเพื่อเลือกจากขวาไปซายโดยคอมท้ังหมดของแผนพื้นถา มันปรากฏมีท้ังหมด 
    “5แผนพื้น” เพื่อใหแนใจจากนั้นใหกดปุม Clear Selection  และทําอีก 
B. คลิก Assign menu > Area Load > Uniform (Shell) แลวจะปรากฏ หนาตางของ Area Uniform  
     Loads ใหเลือก DEAD ใน Load Case Name และเลื่อนลงมาดังจะแสดงในรูปภาพที่ 26 
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รูปภาพที่ 26 
Area Uniform 
Loads form 

  1. เลือก หนวย Ib ft ในชอง Units  
  2. พิมพ 10 ในชอง Load ในสวนของ Uniform Load 
  ทบทวน จําไววา แรงโนมถวงจะไมแสดงออกในแนวแกน Z 
  3. คลิก OK เพ่ือยอมรับโหลดตายตัว 
 C. คลิกคอมเพื่อเลือกท้ังหมดของแผนพื้นจากขวาไปซาย หรือคลิก Select menu > Get Previous  

     Selection หรือคลิกปุม Get Previous Selection  เพื่อกลับไปเลือกแผนพืน้ท้ังหมดอีกครั้ง 
 D. คลิก Assign menu > Area Load > Uniform (Shell) จะปรากฏ หนาตาง Area Uniform Load  
    และเลือก Live จากการเลื่อนรายการลงมาดู 
  1. เลือกหนวย Ib ft เปลี่ยนไดโดยเลื่อนลง 
  2. พิมพ 100 ในชองโหลดในสวน Load area 
  3. คลิก OK เพื่อรับนํ้าหนักจร 
 E. คลิก Assign menu > Clear Display of Assigns เพื่อ ไมใหแสดงโหลด 
 
 
 
 
 
 
 
 
 
 

2-27 



ขั้นท่ี 7 กําหนดแกไขความแข็งแรงของพื้นท่ี (Assign Area Stiffness Modifiers) 
ในขั้นน้ี คุณสมบัติของผิวของแผนพื้นจะถูกละเวนจากการกระทําจากผิวฉาบสําหรับจุดตอของโครงสรางใหอยูใน
มุมมองระนาบ XY @Z= 0 และใหโปรแกรมอยูในโหมดตัวเลือก 
 
 A. คลิกคอมท้ังหมดของของแผนพื้นจากขวาไปซาย หรือคลิกคําสั่ง Select menu > Get Previous  

     Selection หรือคลิกท่ีปุม Get previous Selection  แลวมันจะเลือกท้ังหมดของแผนพื้น 
 B. คลิกคําสั่ง Assign menu > Area > Area Stiffness Modifiers แลวจะปรากฏหนาตาง  

     Property/Stiffness Modification Factors ดังในรูปภาพที่ 27 

 

รูปภาพที่ 27 
Property/Stiff
ness 
Modification 
Factors form 

 
 1. พิมพ 0 ในชองของ Membrane f11 Modifier 
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 2. พิมพ 0 ในชองของ Membrane f22 Modifier 
 3. คลิก OK เพื่อยืนยันการเปลี่ยนแปลง 
 
 C. คลิก Assign menu > Clear Display of Assigns เพื่อเคลียหนาจอจากการแกไข 
 D. ทําในมุมมอง 3D โดยคลิกเมาสบริเวณใดๆ ก็ได ในหนาตาง และคลกิคําสัง่ View menu > Show  

     Gird แลวมันจะปดการแสดงเสนโครงรางในมุมมอง 3D ซึ่งจะแสดงเฉพาะรูปของ Model 
 E. คลิก File menu > Save หรือ กดปุม Save  เพื่อเซฟ Model 
 
ขั้นท่ี 8 เริ่มการวิเคราะห (Run the Analysis) 
 ในขั้นน้ี จะทําการวิเคราะห 
 A. คลิก Analyze menu > Run Analysis หรือคลิกปุม Run Analysis แลวปรากฏหนาตางของ  

     Set Analysis Case to run ดังในรูปภาพที่ 28 

 

รูปภาพที่ 28 
Set 
Analysis 
Cases 
to Run 
form 

 
 
 
 
 
 
 
 
 
 
 

2-29 



หมายเหตุ ในโปรแกรมจะกําหนดโดยอัตโนมัติใหมีการวิเคราะหท้ัง DEAD, MODAL และ LIVE โหลดซึ่งเปน
โหลดพื้นฐานเพื่อคาดการลวงหนาซึ่งโปรแกรมจะตองการอยางนอย1 อยางสําหรับชนิดของโหลด, ถึงแมวาจะไมได
กําหนดฟงกชันไดนามิก 
 1. เลือก MODAL ในชอง Case Name 
 2. คลิกปุม RUN/Do Not Run Case สําหรับ MODAL  
    เปน Do Not Run น้ันเปนความตั้งใจเพื่อการวิเคราะหท่ีเปนจริง 
 3. คลิกปุม Run Now 
โปรแกรมจะทําการสรางสวนการวิเคราะหซึ่งเปนสวนพื้นฐานของขอมูลของ Sap 2000 ในไมชา มันจะแสดง “การ
วิเคราะห” รอสักครู ขอมูลท้ังหมดจะอยูในหนาตางไปพรอมกับการวิเคราะห, ซึ่งเราสามารถเรียกดูขอมูลทีหลังได
โดยคลิก File menu > Show Input/Output Text File และเลือกดูในไฟลท่ีเปนนามสกุล .LOG 

B. เม่ือทําการวิเคราะหเสร็จ จะแสดงขอความ “ANALYSIS COMPLETE” ใหคลิกปุม OK เพื่อปด
หนาตาง, ซึ่งตัวโปรแกรมจะทําการแสดงการเปลีย่นแปลงรูปรางของแบบจําลองและแบบจาํลองจะ

ถูกลอก ซึง่มีปุม  เพ่ือแสดงการ Lock/Unlock ปรากฏให โดยการลอกแบบจําลองก็เพื่อปองกันการ
เปลี่ยนแปลงใดๆที่จะมี ผลตอการวิเคราะหแบบจําลอง 

 
 
ขั้นท่ี 9 กราฟฟคตรวจดูผลลัพธจากกการวิเคราะห (Graphically Review the Analysis Results) 
 
 ในขั้นน้ี ผลการวิเคราะหจะถูกแสดงใหดูในรูปของกราฟฟค 
 A. ใหมุมมองอยูในระนาบ XY @Z=0 โดยคลกิท่ี ปุม XZ View   เพ่ือเขาสูมุมมอง 
 B. คลิกท่ีปุม Show Frame/Cables Forces/Stresses   หรือคลิกคําสั่ง Display menu > Show  

     Forces/Stresses > Frames/Cable  
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 จะปรากฏหนาตางของ Member Force Diagram for frames ดังในรูปภาพที่ 29 
 1. เลือก DEAD ในชอง Case/Combo Name  
 2. เลือก Axial Force  
 3. คลิกท่ี Fill Diagram 
 4. คลิกท่ีปุม OK และรูปแสดงแรงในแนวแกนจะ 

    ปรากฏดังในรูปภาพที่ 30  
 

 

 
 
 
 
 
 
 

 
 

รูปภาพที่ 29 
Member 
Force 
Diagram for 
Frames form
รูปภาพที่ 30 
Axial force 
diagram in 
an elevation 
view 
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 C. คลิกขวาบนเฟรม ในระนาบ XZแลวจะปรากฏหนาตางของ Diagram for Frame Object  
   ดังในรูปภาพที่ 31 

 

รูปภาพที่30 
Force details 
obtained by 
right-clicking 
top chord of 
truss in the 
elevation 
view 
in Figure 29 
 

 
 หมายเหตุ โปรแกรมจะแสดงแผนภาพของแรงทีเ่กิดขึ้นของเฟรมที่เลือกท้ังหมดโดยจะแบงยอยเปนสวน 

ในการวิเคราะหโดยอัตโนมัติ 
 
1. คลิกท่ี Scroll for Values แลว แผนภาพจะปรากฏซึ่งสามารถเอาเมาสไปคลิกในสวนของแผนภาพ 
   เพื่อดูการเปลี่ยนแปลงของแรงในคาน 
2. คลิกปุม Done เพื่อปดหนาตาง 
 
D. ทําใหอยูในระนาบ XZ แลวคลิกคําสั่ง Display menu > Show Deformed Shape หรือ คลิกปุม  
     Show Deformed Shape   
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แลวจะปรากฏหนาตางของ Deformed Shape ดังในรูปภาพที่ 32 
 1. เลือก LIVE ในชอง Case/Combo Name 
 2. เลือก Cubic Curve 
 3. คลิก OK แลวปรากฏการเปลี่ยนแปลงดังในรูปภาพที่ 33 
 

รูปภาพที่ 32 
Deformed 
Shape form 

 
 
 

รูปภาพที่ 33 
Deformed Shape 
in an elevation 
view 
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E. คลิกขวาบนจุดตอใดๆ ในรูปภาพที่ 33แลวจะปรากฏผลของ joint Displacement ดังในรูปภาพที่ 34 

 

รูปภาพที่ 34 
Joint Displacements 
obtained by rightclicking 
a joint shown 
in the elevation view in 
Figure 32 

 
 F. ปดหนาตาง Joint Displacement 
 
ขั้นท่ี 10 ออกแบบเฟรมเหล็ก (Design the Steel Frame Object) 
ในขั้นตอนน้ี จะเปนการออกแบบเฟรมเหล็ก 
หมายเหตุ ในโครงสรางจะทําการวิเคราะหเสร็จกอนท่ีจะทําในสวนน้ี 
 A. คลิก Option menu > Preferences > Steel Frame Design จะแสดงสวน Steel Frame Design  

    Preferences ดังในรูปภาพที่ 35 

 
 
 
 

รูปภาพที่ 35 
Steel Frame Design 
Preferences form 
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 1. คลิกของสวนในชอง Values จะเห็นรหัส มากมายใหเลือก รหัส AISC – ASD89 
 2. กลับไปดูขอมูลท่ีแกไขในชองใหดี แลวคลิก OK เพ่ือยืนยันการเลือก 
  
 B. คลิก Design menu > Steel Frame Design > Start Design/Check of Structure หรือคลิกท่ีปุม  

    Start Steel Design/Check of Structure   เพื่อเริ่มการออกแบบเฟรมเหล็ก.  
   โปรแกรมจะออกแบบเฟรมเหล็ก โดยเลือกเหล็กท่ีประหยัดท่ีสุดโดยเลือกจาก TURSS โดยอัตโนมัติ 
   เพื่อทําการวาด 
 
เม่ือออกแบบเสร็จ ขนาดของเฟรมเหล็กจะแสดงใน Model ซึ่งจะปรากฏดังรูปภาพที่ 36 

 
 รูปภาพที่ 36 

Model after the initial steel frame design 
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C. คลิก Design menu > Steel Frame Design > Verify Analysis Vs Design Section และจะ       
    ปรากฏ ขอความดังในรูปภาพที่ 37 แลวคลิกท่ี No เพื่อปด 

 

 
หม
 

รูปภาพที่ 37 
Analysis vs Design 
Section warning 
message 
  

ในการวิเคราะห (ขั้นท่ี8) โปรแกรมจะเลือกโดยใชนํ้าหนัก จาก TRUSS เปนการเลือกโดยอัตโนมัติ 
ระหวางการออกแบบ (ในขั้นตอนน้ี) โปรแกรมจะใชตัวเลือกเหลาน้ันในการวิเคราะห ขอความในรูปภาพที่ 
37 แสดงใหเห็นถึงการวิเคราะหและออกแบบที่แตกตาง 
 
ในจุดมุงหมายของการวิเคราะหและออกแบบจนกระทั้งมีความแนนอน หมายเหตุ เม่ือมีการวิเคราะห
สะพานอีกครั้ง Sap2000 จะออกแบบหนาตัด (ดูตัวอยางในขั้นท่ี10) ดังน้ันจะทําการวิเคราะหหนาตัด
ตอไป 
 
D. คลิกขวาหนึง่ทีบนโครงทักท่ีอยูจุดบนเฟรมในมุมมองระนาบ XZ ดังแสดงในรูปภาพที่ 36 ซึ่งจะ   
   แสดงขอมูลของเหล็กดังในรปูภาพที่ 38 หมายเหตุ รายงานของสวนการวิเคราะหและออกแบบมีความ 
   แตกตางกัน 
ในสวนของโครงสรางหลักของรายการออกแบบของเฟรมที่รับอัตราความเครียดและโหลดเขาดวยกัน 

ายเหตุ โปรแกรมจะทําการสรางรหัสเฉพาะ เพื่อรวมโหลดสําหรับการออกแบบเฟรมเหล็ก 
 
ดังน้ัน โปรแกรมที่ออกแบบจุดตอจะใชการคํานวณแบบเดียวกันเชนเดียวกับการวาดก็เหมือนกัน ถึงแม 
โปรแกรมจะมีการแบงการวิเคราะหแบบอัตโนมัติก็ตาม 
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รูปภาพที่ 38 
Steel Stress Check Information form 

 
คลิกปุม Detail ท่ีอยูบน Steel Stress Check Information จะปรากฏ Steel Stress Check 
Information AISC-ASD89 หมายเหตุ คุณสามารถพิมพขอมูลออกมาจากคําสั่ง File menu 
 

 
 รูปภาพที่ 39 
 Steel Stress Check Information AISCASD89 form 
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คลิก X ท่ีอยูมุมบนขวามือ เพื่อปดสวนของ Steel Stress Check Information AISC-ASD89เพื่อปด 
 
คลิกปุม Cancel เพื่อปดสวนของ Steel Stress Check Information 
 
E. ถาตองการคาํนวณเพื่อวิเคราะหหนาตัดโครงสรางใหม คลิกคําสั่ง Analyze menu > Run Analysis  
   หรือกด ปุม Run Analysis   และเมื่อคลิก Run แลวจะปรากฏการประมวลผลบนหนาจอ 
 F. เม่ือการวิเคราะหเสร็จ คลิก OK เพื่อปดหนาตางการวิเคราะห คลิก Design menu > Steel Frame    
      Design > Start Design/Check of Structure หรือกดปุม Start Steel Design/Check of  
      Structure เพ่ือเริ่มการคํานวณการออกแบบเหล็ก 

 G. เม่ือออกแบบเสร็จแลวใหคลิกคําสั่ง Design menu > Steel Frame Design > Verify Analysis vs.  
     Design Section แลวจะปรากฏขอความดังในรูปภาพที่ 40 

ขอคว
NO 

 
วนกล
อาจต

 
H. เม
     V

 
 
 
 
 
 
 

รูปภาพที่ 40 
Analysis vs Design 
Section message 
 
 

ามในรูปภาพที่ 40 แสดงถึงตวัเลขของหนาตัดโครงสรางที่แตกตางจากสวนของการออกแบบ กด 
ถาหนาตัดไมเหมาะสม กด OK ถาเหมาะสม เพื่อปดสวนน้ี 

ับไปทําซ้ําขั้นตอน E และ G จนกระทั้งขอความที่แสดงวาการวิเคราะหและออกแบบเหมาะสม สิ่งน้ี
องทําซ้ําไปหลายครั้งโดยยดึหลักความซับซอนของแบบจําลอง 

ื่อทําการออกแบบและวิเคราะหหนาตัดแลว คลิก Design menu > Steel Frame Design >  
erify all Members Passed ซึ่งจะเปนรูปแบบที่ คลายกันดังรูปภาพที่ 41 เม่ือเฟรมทั้งหมดผาน  
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รูปภาพที่ 41 
Stress/capacity 
check message 

 หมายเหตุ member ไมผาน แสดงวา หนาตัดไมเพียงพอในการเลือกอัตโนมัติ เน่ืองจากโปรแกรมยังคง
ใชหนาตัดสวนใหญในการคํานวณโดยอัตโนมัติท้ังการวิเคราะหและออกแบบ โดยขอความจะแสดงทุกครั้งวาไม
ผานน้ันเปนการเลือกจากรายการแกไขโดยอัตโนมัติ ในกรณีน้ัน ในการเพิ่มหนาตัดในการเลือกอัตโนมัติ หรือ
กําหนดหนาตัดใหใหญขึ้น ซึ่งไมสามารถทําไดและไมสามารถคาํนวณและออกแบบได 
 
 I. คลิก File menu > Save หรือปุม Save เพื่อเซฟ Model  
 
 

น้ีเปนการสอนการใช SAP 2000 Version 8  
โดยสมบูรณ 
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